
» Cloud Services for Collaboration
» 10 Great Typography Books
» Using Google Fonts in InDesign

DIGITAL ASSET 
MANAGEMENT 
SYSTEMS

MAY 2018  /  ISSUE #109

SPECIA
L 

REPRIN
T!



75/65/50/50

Become a Member of InDesignSecrets!

 Creating  a Hometown  
Alphabet

Table Effects
RAND InDesignerSeptember 2017

M A G A Z I N E  101

 

Fun

O
utput

Interactive
Colors
Im

ages
D
ocum

ents
Layout
Tables

T

Text

The InDesign Script-o-pedia

> Excel and XML: A Powerful Duo

> Meet the InDesign Scripters

> Ebook Design
August 2016
M A G A Z I N E  88

October 2017
M A G A Z I N E  102

 

 digging deep into 
Dictionaries

» Pinback Button FX
» InDesign 102
» Autumn Add-ons

November  2016
M A G A Z I N E  91

InDesign 
Magic

* InDesign CC 2017

* Roald Dahl Dictionary

* InDesign to WordPress

November 2017
M A G A Z I N E  103

3D Made Easy 
With Adobe Dimension CC
plus  »InDesign CC 2018  »InQuestion  »Output Factory

 

Editorial Tools

» 10 Terrific Image Tips

» InCopy Tricks

»  Amazing Resources 
for InDesign Users

Plus:

January  2017
M A G A Z I N E  93

 

December 2017
M A G A Z I N E  104

 

» Cacidi Charts cc  » Adobe Spark Post  » making Yearbooks

Accessibility

▶ Stroke Styles   ▶ Scripting Tips   ▶ CreativePro Week

June 2017
M A G A Z I N E  98

Animation 

Effects

OUR 100 TH 

ISSUE

August 2017
M A G A Z I N E  100

 

100 Tips &
100 Scripts!

+ Bulleted Lists
+ InQuestion

+ InFocusJuly 2017
M A G A Z I N E  99

Automated Publishing

 

Premium members receive InDesign 
Magazine, plus many other great benefits! 

Visit indesignsecrets.com/membership 
for all the great reasons to join. Use the 
discount code REPRINT to get $10 off!

http://indesignsecrets.com/membership


BY Conrad Chavez

COLLABORATING 
THROUGH CLOUD 
SERVICES

Options for InDesign 
workgroups
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COLLABORATING THROUGH CLOUD SERVICES

Publishing is usually a 
collaborative effort, but many 
software tools are still built as 
if each computer is an island. 
Large organizations have 
the resources to invest in a 
workgroup solution, typically 
custom-built and installed by a 
system integrator, to connect a 
large team of users, streamlining 
their workflow for InDesign 
and other applications. But 
when the investment in time 
or money required for a custom 
solution is more than a small or 
constantly-changing workgroup 
can justify, it’s worth exploring 
simple and flexible solutions 
involving one or more low-cost, 
easily adopted cloud services.

Perhaps the most common 
workgroup sharing tool is also 
the most problematic: email. 
Sure, email is still a popular 
way to share files, because 

everyone is familiar with it. 
But sharing files through email 
creates several complications 
in a production environment. 
Alternatively, cloud storage 
services can make it easier to 
manage versions, preserve 
InDesign links, and transfer 
very large or numerous files that 
may run into file size limits for 

email attachments—while being 
almost as simple to use as email.

Cloud-based solutions come in 
a dizzying array of choices. And 
the right answer doesn’t always 
mean the most technically 
advanced solution. Let’s walk 
through some of the possibilities 
for working with InDesign files 
and the graphics you’ll add to 

them, as well as some options for 
copyediting workflows.

Understanding the Basics 
of File Sharing With 
Dropbox
The most popular cloud-sharing 
service is also one of the easiest 
to use: Dropbox. You might have 
used a service such as Dropbox 
to easily transfer work between 
your own computer and mobile 
devices. But if you haven’t used 
it to share files with others, 
here’s a quick overview of how 
that works.

Dropbox functions both 
on your device and in a web 
browser. Because the web 
browser option is identical on 
both Mac and Windows, I’ll 
focus on that option here. In a 
web browser (FIGURE 1), the left 
panel displays sections such as 
My Files, Sharing, File Requests 

FIGURE 1. Hovering over a Dropbox item displays a Share button. Clicking the menu 
button reveals more options that also include Share.
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COLLABORATING THROUGH CLOUD SERVICES

(asking others to share files with 
you, like Sharing in reverse), and 
Deleted Files (restore files you’ve 
trashed). You typically start from 
the My Files section on the left, 
and then click the file or folder 
you want to share. In a Dropbox 
file view in a web browser, each 
item has a menu with several 
options. For collaboration, some 
of the most important options 

are Share, Download, Add 
Comment, and Version History.

The Share option (FIGURE 2) 
lets you send an email link to a 
colleague. When they click the 
link, Dropbox adds the file or 
folder to their Dropbox account 
so they can download or view the 
file or folder on their computer 
or mobile device. Because it’s a 
link and not an email attachment, 

FIGURE 3. Comments can help colleagues clarify how to use or edit shared content.

there’s no file transfer time or 
email file size limit.

The Download option does 
what you expect: It transfers 
the file from the cloud server to 
your web browser’s designated 
folder for downloads. The Add 
Comment option (FIGURE 3) lets 
you post a comment on Dropbox; 
it can also be seen by someone 
you sent a Share link to.

Version History (FIGURE 4, NEXT 

PAGE) keeps older versions of a 
document. If the current version 
contains a mistake or becomes 
corrupted, you can select an 
older version to make it the 
current version. The oldest 
version is the one initially 
uploaded to Dropbox; anything 
older than that needs to come 
from your own local backups.

FIGURE 2. Share invites a colleague to add your selected content to their Dropbox account.
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COLLABORATING THROUGH CLOUD SERVICES

The Sharing section (FIGURE 5) 
lets you manage the folders, files, 
and links that you’ve shared and 
that others have shared with you.

As I said, there are many alter-
natives to Dropbox, including 
Google Drive, Microsoft 
OneDrive, Apple iCloud Drive, 
Box.com, and Adobe Creative 
Cloud Files. They’ll work slightly 
differently, but you’ll typically 
find collaboration features in the 
menus that provide settings for 
files and folders. 

If you’re on the go, many of 
these options are also available 
in the mobile app versions of 
these services. For example, if 
someone needs a file and it’s 
in your Dropbox account, you 
can send them a Share link 
from the Dropbox app on your 
smartphone.

FIGURE 4. Version History 
is like a multi-step undo 
command, but at the file level.

FIGURE 5. The Links tab in the 
Sharing section lists links you’ve 
shared, so that you can adjust 
permissions and other settings.
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COLLABORATING THROUGH CLOUD SERVICES

There’s much more to learn 
about Dropbox—consider 
watching Keith Gilbert’s 
excellent video series, Learning 
Dropbox, on Lynda.com/
LinkedIn Learning.

Using Cloud File Sharing 
Services with InDesign
As always, your workflow 
should be designed to bring 
content into InDesign as linked 
files—typically using the Place 
command—for maximum flexi-
bility when text or graphics need 
to be updated.

But you can’t use the Place 
command with text or graphics 
that you see in a web browser. 
So, for example, you can’t place 
a file that you’re viewing on the 
Dropbox website. Fortunately, 
if you installed the Dropbox 
application on your computer, 
it continuously synchronizes 

shared files and folders between 
the Dropbox cloud server 
and a Dropbox folder on your 
computer. You can place the 
file from that local folder into 
InDesign, and InDesign can 
maintain the link to that file as 
long as that copy exists on your 
computer.

Dropbox has a Download 
option; however, the Share 
option is preferable if you’re 
collaborating. Because your web 
browser’s downloads folder is 
typically local and accessible 
only to you, the Download 
option is useful only if you no 
longer want that file to be edited 
by others.

The other cloud file sharing 
services listed earlier work 
similarly to Dropbox. Contribu-
tors can add content through 
their computers, web browsers, 
and mobile devices, and you can 
place the files from your local 
synchronized folder. (Creative 
Cloud offers another important 
method, which I cover below.)

SHARING FILES WITH SOMEONE WHO DOESN’T HAVE DROPBOX
Got a colleague who doesn’t have Dropbox? You can still share files with them via hyperlinks, 
created with the Dropbox desktop app on your computer. Right-click the file and click Copy 
Dropbox Link on the Mac, or, on Windows, choose Share, and then choose Create Link. With 
the link copied to your clipboard, you can paste it into an email, text message, or anywhere 
else you share hyperlinks. When your colleagues click that link, the file or folder will open in 
a web browser and allow them to download the file. If you have the Professional or Business 
version of Dropbox, you can limit access by password-protecting these links and setting 
expiration dates for them. Sharing links this way doesn’t foster true collaboration, but it’s 
very handy if you just want to give a file to someone, whether or not they use Dropbox.
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Avoiding version conflicts

When you share documents 
through a cloud service, there’s 
potential for confusion over 
which version of a document is 
current. Two people may try to 
edit the same file at the same 
time from different locations. 
If the cloud service you use 
can’t prevent multiple users 
from editing the same file 
simultaneously, a conflicted 
copy will probably result. When 
this happens, the version that 
InDesign is linked to may not 
be the correct version. You now 
have to figure out which copy 
has the latest changes, or if both 
copies have changed and need to 
be merged manually.

Ideally, a cloud service would 
lock out all other users when one 
is editing a document. And some 
cloud services offer file locking 
as part of a paid or premium tier, 

in which case it may be worth-
while to upgrade to one of those 
plans to prevent conflicts. If your 
cloud service doesn’t provide 
that feature, make sure your 
team has a procedure for letting 
others know when they need to 
stay out of a file. Some people 
coordinate file handling using 
the group chat tools in services 
such as Slack or Basecamp.

When you open an InDesign 
document on your computer, 
InDesign creates a lock file 
(FIGURE 6) in the same folder, 
using the same name as the 
opened file, but starting with a 
tilde (~) and ending with an .idlk 
filename extension. The lock file 

is supposed to prevent multiple 
users from opening the same 
InDesign file. Unfortunately, 
it doesn’t always work when 
the InDesign file is stored on a 
cloud service, which of course 
may result in conflicted copies. 
If your own testing shows that 
this is a problem on the service 
you’re using, you must find 
another way to coordinate your 
workgroup to avoid editing 
conflicts.

The version history feature 
mentioned earlier can help 
your workgroup recover from 
mistakes related to a version 
conflict, or when a file is acci-
dentally deleted.

Creative Cloud Options  
for Collaboration
Because all InDesign CC users 
have a Creative Cloud subscrip-
tion, it’s worth looking at the 

ways that Creative Cloud can 
store and share content.

Creative Cloud Files is similar 
to Dropbox-type services in how 
it works and in being able to 
store, retrieve, and share files on 
desktop and mobile devices. But 
Creative Cloud Files offers some 
unique advantages. For example, 
Photoshop files saved in the 
Cloud offer an Extract button 
that lets you view document 
fonts, colors, styles, layers, and 
gradients from within your web 
browser, and you can download 
those components individually. 
When no documents are open in 
InDesign, you can open Creative 
Cloud files directly from the CC 
Files section of the Start screen.

However, Creative Cloud Files 
storage isn’t perfect. If multiple 
users open an InDesign file 
stored in Creative Cloud Files, 
the InDesign lock file conflict 

FIGURE 6. The InDesign .idlk lock file 
appears when an InDesign file is open. The 
green icons indicate Dropbox sync status for 
those local files.
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mentioned earlier may occur, so 
workgroup coordination remains 
essential.

Earlier web versions of 
Creative Cloud Files supported 
features such as version control, 
and could show you the color 
themes and fonts used in an 
InDesign document. At the time 
this article was published, the 
Creative Cloud Files website was 
undergoing a major redesign, 
and some features are not 
currently implemented. Keep 
an eye on the web version of 
Creative Cloud Files to see what 
Adobe adds as the redesign 
progresses.

You can also share content 
through Creative Cloud Libraries. 
Unlike Dropbox-type services, 
Creative Cloud Libraries operate 
at the level of objects, not entire 
files. This makes Creative Cloud 
Libraries a great way to share 
color swatches, text, object 

styles, objects and other artwork, 
and Photoshop layers or images 
(FIGURE 7). For more information 
about sharing with Creative 
Cloud Libraries, see Issue #83.

Collaborating on Copyedits
The cloud sharing services 
mentioned above also work with 
files that contain text copy (such 
as Microsoft Word files), and 

multiple writers and editors can 
create and edit these files before 
they’re placed into InDesign. 
However, once the file is placed 
into InDesign, it becomes more 
challenging to collaborate on 
text. If your workgroup requires 
this kind of ongoing editorial 
collaboration, you may need one 
of the following solutions.

InCopy is a great solution…
sometimes
If you need a way to coordinate 
the editorial workflow of an 
InDesign publication and you’re 
familiar with Adobe InCopy, you 
might naturally gravitate to a 
solution built around InDesign 
and InCopy. InDesign stories can 
be assigned to contributors who 
can use InCopy to see how well 
their writing fits the layout, and 
their work flows right back into 
the InDesign document. Editors 
don’t need the full Creative 

Cloud subscription; a single-app 
subscription to InCopy CC is 
$4.99/month per seat. 

The InCopy workflow works 
best when the InDesign file 
and its shared text content 
(linked InCopy files) are on a 
local file server to which all 
InDesign and InCopy users have 
read/write access. As long as 
everyone works directly off the 
server, InDesign and InCopy 
can easily track the “check-out” 
status (locked or available) of 
each assignment in real time, 
preventing version conflicts. 
Also, it helps for everyone in 
the workgroup to be a regular 
contributor, so they can be 
trained to be competent and 
efficient in using InCopy.

The InCopy workflow works 
almost as well with Dropbox 
or Google Drive. If you store 
the InDesign file and its 
linked InCopy stories in a 

FIGURE 7. Creative Cloud Libraries are a way 
to share objects, styles, and components 
with collaborators.
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locally-synced folder from either 
of these cloud services, and 
share that folder (collaborate) 
with remote InCopy users who 
have installed the Dropbox or 
Google Drive software on their 
computers as well, you can 
set up a remote workflow for 
everyone, without needing a 
local file server. All users will 
need some training in best 
practices, such as never copying 
the files to a location outside of 
the shared folder; but you’d need 
to educate them with the same 
cautions if they’re working on a 
local file server. Also, while both 
of these services do fast back-
ground syncing of the check-out 
status of stories in a layout, 
neither syncs the lock status 
of the InDesign layout itself. 
Designers will need to be careful 
about opening layouts that 
someone else might already have 
open to avoid the “conflicting 

THIRD-PARTY EDITORIAL COLLABORATION
While some groups collaborate online using the current version of Microsoft 
Word, many organizations are building workflows around Google Docs because 
of its accessibility and simplicity. Of course, there’s a gap when trying to 
integrate InDesign with a Google Docs workflow, because InDesign can’t 
natively place a Google Docs file online or through Google Drive.

Fortunately, this workflow gap has been filled in by an independent 
InDesign developer: Em Software comes to the rescue. They make a plug-in 
called DocsFlow, which adds Google Docs support to InDesign through 
commands it adds in a File > DocsFlow submenu. Choose File > DocsFlow > 
Place from Google Docs, sign in to your Google account, and you can then 
place a Google Doc directly from your Google Drive cloud storage using a 
standard InDesign link. The Pro version includes two more valuable features: 
When you edit a placed Google Docs story in an InDesign layout, you can sync 
those changes back out to the linked Google Docs file in the cloud,  
and you can also place a Google Sheets spreadsheet. 

Em Software also makes a similar plug-in for Microsoft Word and Excel files called WordsFlow, which lets you 
link to Word files so that you can continue to make edits and formatting changes in both Word and InDesign (and it 
magically merges them). See David Blatner’s review of DocsFlow in Issue #48 for more information.
If there’s a hole in your collaborative cloud-based InDesign workflow, it’s worth opening InDesign and choosing 
Window > Find Extensions on Exchange to see if there are InDesign extensions that can fill that gap.

When a Google Docs file is placed in 
a selected InDesign story, the text 
frames display a DocsFlow badge.
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file” problem. Luckily, they just 
need to check for the existence 
of the telltale .idlk file in the 
same folder as the InDesign 
file. If it’s there, someone has 
the layout open in InDesign, so 
move on. If it’s not there, the 
layout is safe to open.

None of the other cloud 
services mentioned thus far, 
not even Adobe’s own Creative 
Cloud Files, supports the critical 
check-out status syncing of the 
shared stories in an InDesign/
InCopy workflow. But if you 
know you’ll never have more 
than one person trying to edit 
the same stories at once—such 
as a designer and an editor who 
“take turns” with a publica-
tion—then CC Files, Box, and 
other cloud services that sync a 
local folder with a user’s cloud 
account will work for you. 

Keep in mind that occasional 
contributors are far more likely to 

be familiar with Microsoft Word 
or Google Docs than with InCopy, 
so if a workgroup frequently 
includes a changing cast of free-
lancers or occasional contribu-
tors such as students, it may not 
be practical to expect them to 
become proficient with InCopy 
for just one or two short projects.

Connecting the Dots
Given the wide spectrum of 
options for cloud collaboration, 
and the need to ensure that 
InDesign can operate consis-
tently, be sure to thoroughly 
test any workflow that you 
design around a consumer cloud 
service. Give your workgroup 
a reliable way to avoid version 
conflicts, recognize that a work-
group’s familiarity with certain 
tools may be a strong factor 
in the solution, and maintain 
backups rigorously.

Conrad Chavez is a Seattle-based writer 
and photographer, and is a frequent 
contributor to CreativePro.com and 
InDesign Magazine. You can find out 
more about Conrad at his website, 
conradchavez.com.
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